=

CT200

Electrocardiograph

User Manual

=
www.machealth.com.au
CT200 Electrocardiograph

User Manual

Designed and manufactured in Australia

Manual Revision 8

SYMBOL 227 \f "Symbol" Macquarie Medical Systems 2003

[image: image100.jpg]R

CT200 ECG

FORMAT _AUTO

<ri

FUNCT

R alll || R /O) (macauarie]

0K mm/mV IMm/Sec

%
ip
S





Warnings and Cautions

Please read the following information before using your CT200.

A
DANGER: Risk of explosion if used in the presence of flammable anesthetics.

A
WARNING: Do not operate the unit in the presence of electromagnetic interference. Interference may be caused by electrosurgery, diathermy, or magnetic resonance imaging equipment.

A 
WARNING: Do not use the PC Link connection whilst patient is attached to ECG leads unless the PC is double insulated and complies with IEC601-1 or EN60601-1.

A
CAUTION: The type of electrodes used can effect the systems recovery from overload, especially recovery time after defibrillator pulses. Use electrodes that minimise electrode polarisation.

A
CAUTION: This device is intended for use by persons trained in professional health care. The operator must be thoroughly familiar with the contents of this manual before using the device.

A
CAUTION: Use only the AC adapter (plug pack) supplied to recharge the CT200. Other adapters may not meet required safety standards.

A
CAUTION: Do not operate the CT200 near high voltage equipment that may generate sparks or in an environment where high static electricity is present. 

A
CAUTION: Please ensure the patient leads are in the correct locations on the patients body, and ensure that all leads are connected. If it is impossible to connect certain chest leads to the patient, then connect the unused chest leads to the right leg.

A
CAUTION: To maintain patient safety ensure that equipment connected to the output socket of the unit does not exceed enclosure leakage current limits.

A
CAUTION: Use only the defibrillator protected patient cable DPC 12943 as supplied by Macquarie Medical Systems Pty Ltd. Use of a non-Macquarie Medical Systems cable can cause damage to equipment or harm to patient or give an incorrect reading.

A
CAUTION: The CT200 should not be subjected to water and liquid spillage. It should only be used in a dry environment.

A
CAUTION: Dropping the CT200 may cause device failure or intermittent operation. Contact service if this occurs.

A
CAUTION: The CT200 is not recommended to be used on neo-natal patients.

A
CAUTION: Certain brands of ECG gel may irritate the patients skin. If this occurs, the health care professional should choose an appropriate alternative brand or electrode option.

A
CAUTION: The CT200 is not recommended to be used in critical care situations.

A
CAUTION: Do not mix disposable and reusable electrodes together on the same patient as the same time. This may cause electrode polarisation.
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Introduction

CT200 Electrocardiograph

The CT200 Electrocardiograph is a simple to use but very powerful ECG recorder. Its compact size, light weight, and long battery life make it suitable for portable use, and its formatted printing and archiving capabilities make it ideal for use in a clinic or medical centre.

CT200 Electrocardiograph User Manual

This Manual is divided into two sections.

The first part of the manual, starting on page 6 is the instructions on using the ECG unit as a portable unit.

The second section of the manual, starting on page is the instructions and procedures on using the PC link and Real Time Patient Monitoring software.

If you have any difficulties using the unit or the software, and the procedures set out in this manual do not help you solve your problem, please contact the service department at Macquarie Medical Systems:

Website:
www.machealth.com.au
Email:

mms@machealth.com.au
Phone:

Australian Customers Call:
02 9692 7911



International Customers Call:
612 9692 7911



During Australian Eastern Standard Time Business Hours (GMT + 10:00)

After Hours phone calls will be diverted to Messagebank

Fax:

Australian Customers Call:
02 9692 7965



International Customers Call:
612 9692 7965

Quick Start

Automatic 12 Lead Recording

1.
Push the patient cable plug firmly into the socket on the right-hand side of the unit.

2.
Attach the leads to the patient.

3.
Press [image: image2.png]


 (ON/STBY) to switch on the unit.

4.
The display panel at the top of the unit will show the battery level and either the time or pulse rate, and prompt the user with a message.

5.
To start a 12-lead automatic recording WAIT until the heart rate display has settled (about 10 secs) and press 
[image: image3.png]AUTO



 (AUTO RECORD).

6.
When the recording is complete press  [image: image4.png]


 (ON/STBY) to switch the unit off.

For further details on the steps above and other operating information refer to the Operating Instructions section.

Patient Connections

Electrodes
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Good electrode connection is the most important factor in recording a good quality ECG. By following a few basic steps consistent, clean recordings can be achieved.

1.
Clean the electrode sites with an alcohol swab.

2.
Place a small amount of ECG electrode gel on the metal electrode of the limb strap or clamp. Non-conductive gels (such as ultrasound gel) and water are not suitable for ECG connections.
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Where body hair is present at the electrode sites, use more gel to ensure 

a good connection. It is not usually necessary to shave the patient.

3.
Connect the electrodes a short distance above the ankle or wrist, with the metal part placed on the fleshy part of the limb.

4.
Place a small amount of gel at each of the chest electrode sites, and attach the suction bulbs.


[image: image7.png]



Follow the same procedure for disposable electrodes (no gel is required). Disposable electrodes must only be used once. Re-using these electrodes will always result in poor recordings.

Lead Connections

The following lead name abbreviations and colours are used for the electrode leads:


Australia/USA
     Europe

Lead Name
Code
Colour
Code
Colour

Right Arm
RA
White
R
Red

Left Arm
LA
Black
L
Yellow

Left Leg
LL
Red
F
Green

Chest 1
V1
Red/Brown
C1
Red/White

Chest 2
V2
Yellow/Brown
C2
Yellow/White

Chest 3
V3
Green/Brown
C3
Green/White

Chest 4
V4
Blue/Brown
C4
Brown/White

Chest 5
V5
Orange/Brown
C5
Black/White

Chest 6
V6
Purple/Brown
C6
Purple/White

Right Leg
RL
Green
N
Black

CT200 Operation

The CT200
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Display

The display area shows the amount of battery charge, the time, the patients pulse rate, and help information.


Battery level
Pulse rate
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                          Prompt message
The pulse rate is only present when a patient is fully connected to the CT200. If the patient is not connected the time and a message to check electrodes will be displayed.
Battery Charging

The rechargeable battery in the CT200 gives over 80 recordings when fully charged. To recharge the battery plug the mains adapter into a mains socket and into the power input of the CT200. The green "Battery On Charge" indicator will light if the battery is being charged.

The amount of charge in the battery is shown on the display. 

This bar height indicates that the battery is very low. Only a few more recordings will be possible

[image: image9.png]Batts_
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This bar height indicates that the battery is fully charged.

 If the battery is low the CT200 will beep and display the message Recharge battery. 

If the battery is too low for reliable operation, the message Flat Battery will appear and the CT200 will switch itself off. If this occurs, connecting the CT200 to the mains adapter will allow normal operation while charging the battery. The battery should be charged for 8 hours to reach full capacity.

The CT200 can safely be stored and used while on charge. It is good practice to always leave the CT200 on charge overnight, to avoid an unexpected flat battery.

The CT200 will switch itself off after 10 minutes without use to conserve the battery. While data is stored in memory the CT200 will not switch off. Press [image: image11.png]STOP



 (STOP) to clear the memory and allow the CT200 to switch off.

Automatic Recording Formats

The CT200 has a number of pre-set automatic recording formats. These formats save time by controlling the recording process. A format is selected by pressing the [image: image12.png]FORMAT



 (FORMAT) key once to display the current format, and repeating the press until the desired format is displayed. The following formats are available:

F 1: 

3 Channel + Rhythm: A strip of Leads I, II, III, aVR, aVL, aVF, V1, V2, V3, V4, V5, V6 recorded in 3 channel format, with the addition of a Lead II rhythm strip. The recording time for the leads is pre-set to 3 secs and 6 secs for the rhythm strip. The speed is pre-set to 25 mm/sec.

F 2: 

1 Channel + Rhythm: Standard format as above, recorded in 1 channel format. The recording time for the leads is set by the AUTO LENGTH setting. The recording time for the rhythm strip is set by the RHYTHM LENGTH setting.

Note:  Veterinarian models have the V leads omitted in the above two formats.

F 3: 

3 Channel + Rhythm + Respiration: Standard format with automatic prompting to move Lead V3 to the right of the chest, and for the patient to hold their breath during a second recording of Lead III, in 1 channel format.

F4: 

PC Link: Outputs recorded information to a Personal Computer with the PC Link software.

F 5 : 

Memory: Stores a 12 lead ECG in Memory for future printing on an external printer or output to a Personal Computer.

To start a recording in the selected format, press  
[image: image13.png]AUTO



 (AUTO RECORD).
Automatic Recording

A recording in the automatic format selected is started by pressing the 
[image: image14.png]AUTO



 (AUTO RECORD) key. A calibration pulse, settings, and the time and date will be printed at the start of the recording. A pulse rate and a calibration pulse will be printed at the end of the recording.  To stop recording at any time press the [image: image15.png]STOP



 (STOP) key.

While data is stored in memory no more recordings can be made. 

The CT200 uses "simultaneous acquisition" to store all 12 leads in memory at the same time, so that the print of every lead shows the same time interval, and the patient only needs to remain still for a short time.

The pulse rate printed on the recording is an average over the previous 10 seconds. If a recording is started too soon after connecting the patient, this measurement may not have reached the correct value. Before starting a recording, check the pulse rate displayed on the screen to confirm that the patient is settled and the measurement is stable.

The size of the recorded ECG can be changed by pressing the [image: image16.png]mm/mV



 (SIZE) key. The speed of the recording can be changed by pressing the [image: image17.png]mm/sec



 (SPEED) key. Press the keys once to see the current setting, and repeat the press to change the setting.

The length of the recordings and the amount of information printed can be programmed to suit your application. Refer to the "Setting up the CT200" section of the manual.

Manual Recording

A single lead can be recorded by pressing the [image: image18.png]MANUAL



 (MANUAL RECORD) key. The recording will continue until the [image: image19.png]STOP



 (STOP) key is pressed or the time set by the LEAD LENGTH setting is reached, up to a maximum of 99 seconds.

The lead recorded is selected by pressing the [image: image20.png]


 (LEAD SELECT) key. Press once to see the current lead, and repeat the press to change the lead.

The size and speed of the recording can be changed as described above.

Filters

The CT200 has a range of filter settings to remove muscle noise and mains interference from the recorded ECG.

The muscle noise filter is controlled by the [image: image21.png]


 (FILTER) key. Press the key once to see the current filter setting, and repeat the press to change the setting. The normal setting of max 35Hz filter will give a noise-free recording in most circumstances.

The mains filter is automatic and will remove mains interference when it is present.

Calibration

A 1mV calibration pulse will be recorded as part of the automatic formats. To record a calibration pulse at any other time press the [image: image22.png]imV



 (CALIBRATION) key. The current setting of  size, speed, and filter will be printed underneath the calibration pulse

Loading and Feeding Paper

1.
Remove the paper cover by sliding it to the left. Remove the paper spindle.

2.
Unroll a short length of paper, and cut the end square. Push the paper into the slot at the bottom of the paper holder and press [image: image23.png]


 (FEED PAPER) to feed the paper through the printer.

3.
Place the spindle through the roll, and fit the roll into the cavity. For large paper rolls the outer slots hold the spindle.

4.
Replace the paper cover. The cover is left off for large paper rolls.

Pressing [image: image24.png]


 (FEED PAPER) at any time feeds  paper.

Attaching to a stand

The CT200 can be mounted on the CT200 Stand or on a general equipment stand. Thread the screw through the stand and screw into the hole at the back of the CT200.

[image: image25.png]



CAUTION: To avoid damage to the CT200 use only the 10mm M6 screw provided

The CT200 stand can be used in a number of ways:

[image: image26.png]



Advanced CT200 Operation

Using the PC Link format

The PC Link format allows the CT200 to transfer ECG data to a personal computer. When used with the PC Link software which is on the disk supplied, recorded ECG waveforms can be viewed, interpreted, and archived on the computer.  The PC Link software requires an IBM compatible PC with Windows 3.1 or Windows 95, 98 and 2000.

The CT200 is controlled by the computer in this format. Connect the CT200 to the serial port of the computer using the cable supplied. Connect the patient to the CT200 and switch the CT200 on. The link between the computer and the CT200 can be checked using the PC Link software.

Operation of the PC Link program is described in the separate PC Link section later on this manual. 

Memory format

The Memory format allows one 12 lead ECG to be stored in the CT200's memory for future printing on an external printer or transferral to a PC.

Before saving an ECG in memory the electrode connections should be checked by printing a short strip of a single lead. Select  the Memory format by pressing the [image: image27.png]FORMAT



 (FORMAT) key. Store the ECG in memory by pressing the  [image: image28.png]AUTO



 (AUTO RECORD) key. The symbol M will appear on the display to show that there is an ECG in memory. 

To print on an external printer, select the appropriate format and press  [image: image29.png]AUTO



 (AUTO RECORD). The ECG can be re-printed as many times as desired, and the speed, size, filter and format settings can be changed each time.

To transfer the ECG to a PC follow the PC Link instructions above. If the M symbol appears on the display the data transferred will be from memory. 

You can recall the last ECG saved to memory by using the MR button. This button shall allow you to recall or delete the last ECG in memory. N.B – the ECG will only be deleted once another is recorded.

The ECG in memory cannot be printed on the internal printer.
Setting up the CT200  

The CT200 can be programmed to suit your specific requirements. 

To enter the Set Up mode press [image: image30.png]SET-UP



 (SET UP) . Press the [image: image31.png]


 (FUNCT) key to cycle through the different options, and 
[image: image32.wmf] (SELECT) to choose an option to change or function to perform. The display shows help information at each step of the process. The following options and functions are available:

AUTO LENGTH: This value sets the recording time (in seconds) of each trace for all the internal printer formats. It can be set between 1 and 9 seconds.

Enter the desired recording time using the numbered keys, and press OK 

(OK Button) to store the setting. 

LEAD LENGTH: This value sets the recording time for single lead recordings. It can be set between 1 and 99 seconds. Enter a value as described above.

RHYTHM LENGTH: This value sets the recording time of the Lead II rhythm strip for all the internal printer formats with rhythm. It can be set between 1 and 9 seconds. Enter a value as described above.

TIME and DATE: The time and date can be stored in the CT200 for printing at the start of recordings. Enter the values using the numbered keys, and press OK button to store the setting. Press [image: image33.png]


 (FUNCT) after the time or date is fully entered.

SWITCH-ON VALUES: Pressing OK button when this option is displayed sets the unit to remember previously used settings after power off.

RESET UNIT: Pressing OK button when this option is displayed resets all settings to the factory default values.

TEST PRINT: Pressing OK button when this option is displayed prints out test patterns and service information.

To exit the Set Up mode and return to normal operation press the [image: image34.png]SET-UP



 (SET UP)  key.

Other CT200 Outputs

The CT200 has outputs for specialised purposes.

QRS DETECT OUTPUT
A QRS detect signal is available on the output connector. This TTL level signal pulses low when a QRS signal is detected. Refer to the Specifications section of the manual for connector pin allocations.

CT200 Set Up Chart

Press [image: image35.png]SET-UP



 (SET UP) to enter SET UP cycle.    

Press [image: image36.png]


 (FUNCT) to move in cycle.

Press [image: image37.png]SET-UP



 (SET UP) to exit cycle, at any time.

  SET - UP mode    Use FUNCT

 Test print

Use SELECT

  AUTO length    Use SELECT

  [image: image38.png]


                                         

            
         


  LEAD length    Use SELECT

Reset unit

Use SELECT


Switch-on values

Use SELECT

  Rhythm length    Use SELECT



Date

Use SELECT

Time

Use SELECT


Installingxe "Installation" CT200 PC Link

System Requirementsxe "Installation:System Requirements"
The following table shows the software and hardware requirements needed to install and run CT200 PC Link

Operating System
Microsoft Windows 3.1, Windows for Workgroups (Version 3.11),

                               
Microsoft Windows 95 and Windows NT.

Microprocessor
386 or higher or compatible

Memory

4 MB required, 8MB recommended

Hard Disk space
2 MB + 44K for each ecg file.

Disk Drive

One 3.25 “ high density drive ( for the installation diskette ).

Video Adapter
VGA monitor (Super VGA recommended)

Other
1 free serial Port  (used for recording from the CT200). The Serial port used for recording must be capable of sustaining 19200 baud.

Installingxe "Installation:Steps Required" CT200 PC Link on Your Computer

The following procedure describes the steps required to install CT200 PC Link on your computer.
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1. Start Microsoft Windows and ensure that all applications are closed.
2. Insert the CT200 PC Link Version 5 Setup Diskette into Drive A or Drive B.
1.
From the Windows Program Manager, choose Run from the File menu, a dialogue box will pop up.

[image: image40.wmf]
1. In the Command Line box type A:\SETUP, where A is the drive letter of the 3.25” drive.
2. Choose the OK button to start the installation, then follow the instructions on the screen.
Special Notesxe "Special Notes":

1. The format of the Date and Time expressions in CT200 PC Link program is dictated by the International settings in Microsoft Windows. If you prefer to have the Date and Time formats displayed with accordance to your locality, you should setup your International Settings to reflect your preferred format. See  Appendix E - Date and Time Formats at the end of the manual for further details.
2. CT200 PC Link uses a large area of your screen to show you as much information as possible. For this reason, CT200 PC Link is best run in any of the Super VGA modes(16 colours 800x600 or greater). Despite this, CT200 PC Link will run sufficiently in VGA mode. See Appendix D - Changing VGA mode for further details.

Getting Startedxe "Getting Started" with CT200 PC Link


[image: image41.wmf]
1. To get started with CT200 PC Link go to the Windows Program Manager and find the group called CT200 PC Link Utility. To startxe "Getting Started:Starting PC Link" CT200 PC Link Utility, ensure that the group window is open, and simply double click on the program icon (displayed to the left).

2. When CT200 PC Link has completed loading you will see the main work space on the screen. The main work space of CT200 PC Link has a Title Bar entitled CT200 PC link - [New Patient], beneath is the Menu bar starting with File, Edit, Record, Options ..., and the Tool Bar (row of picture buttons).


[image: image42.wmf]
1. Lets start by viewing a previously recorded ECG which is provided with the installation. Firstly, from the File Menu- select Retrieve Filexe "Retrieve: File" ... A dialogue box entitled Recall ECG Files will appear.

2.
Select the file named TEST.SCP and click OK. This ECG     

     will be loaded and displayed.

[image: image43.png]
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1. At the top of the Window you will notice the Tool Bar. The Speed and Size buttons affect the Horizontal and Vertical scale of the ECG trace in much the same way as an ECG recorder.

Getting Started xe "Getting Started:ToolBar"with the CT200 PC Link Utility ToolBar

[image: image45.png]



1. The Retrieve buttonxe "Tool Bar:Retrieve" will display the Patient Indexxe "Patient Index" which allows the user to select one or more recordings for display.

[image: image46.png]



1. The Print Button

2.  will print what is currently on the screen.

  [image: image47.png]



1. The Record Button is used to begin recording of an ECG from the CT200 ECG monitor.

[image: image48.png]



1. The Channel  button affects how the 12 leads are displayed in the Lead Display Window(s). There are three settings: 3,6 or 12 Channel formatxe "Channel Format". The button will change to reflect the current setting.

[image: image49.png]



1. The Patient Button displays the Patient Details and allows the user to enter new details or modify existing details. Comments may also be entered within this     

                window.

[image: image50.png]



1. The Compare buttonxe "Tool Bar:Compare"

xe "Compare: Button" will display all the currently loaded ECG recordings, one lead at a time. ie the user can see the same lead from different recordings at the same time. NB you may only compare files for the same patient. See also Compare button and Compare Mode
[image: image51.png]



1. The Measure Button will display the Measurement Panel
 which assists the user in making measurements from which calculations and diagnostic indications are derived and displayed.

[image: image52.png]



1. The Page left and right arrow buttons display the next and previous Recordingsxe "Recordings" when more than one recording is loaded.

The remainder of this document describes the various components and  features of the CT200 PC Link Utility in more detail. 

Using the Toolbar:  

If you are in doubt or have forgotten the function of a button on the Tool Bar place the cursor over the button and in a second its name/function will be displayed over it.

Context Sensitive Help: 

On-line context sensitive help is also available. You may bring up the online help simply by pressing the F1 (function 1) key on the keyboard and relevant help will be displayed for your current operation. See also the Help menu.
CT200 PC Linkxe "Overview" Overview

CT200 PC Link Utility uses what Microsoft calls the Multiple Document Interface or MDI. The MDI is used in various windows applications such as the Program Manager and Microsoft Word. For users that are unfamiliar with the Windows concept, please refer to the Windows manual and or use the Windows Tutorial which is in the help menu of the Windows Program Manager. 
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Figure 1 - CT200 PC Link Utility MDI interface
A MDI interface has a main window and one or more sub windows. Each window is boxed with a title bar. In the top left hand corner of each window is a Control-Menu box, this is specific to the current window. A single click of the mouse button on the Control-Menu box brings down a list of possible actions, a double click of the mouse button will close the window. A double click on the main window Control-Menu box will close the PC link program. 

The main window’s title bar displays the program’s name. Sub windows usually display the title of the current file or “New Patient” (as in the case of CT200 PC Link). When there are more than one sub windows the currently active sub window will have its title bar highlighted. To activate a sub window position the mouse pointer over the desired window and click the mouse. To perform any action on a displayed window the window must first be made active.

CT200 PC link Utility uses the MDI to display multiple recordings when performing a compare. Please refer to the section on Compare Mode. When more than one recording for a patient has been retrieved the windows will size to display all the recordings on the screen at the same time. If recordings of different patients have been retrieved only one recording will be displayed. The main window has a horizontal list of functions, this list is known as the Menu Bar. To view a list of retrieved recordings use the Menu Bar Window Menu ( see Figure 1 ).

To activate a Menu Bar item move the mouse pointer over the menu item and depress the mouse button. By moving the mouse pointer to a patient name in the list and releasing the mouse button the window containing that patient will be displayed and made active. Note that the Page Left/Right Buttons at the top left of the window also have the same effect.

The Menu Bar

The following section gives an overview of the function of the menu items. Each menu item is individually looked at with a small description of the menu item’s operation.

File   Edit     Record     Options     Display Settings    Window    Help

The File menu

xe "Menus: File"
Retrieve File...xe "Retrieve: File" 
This menu item allows the user to open individual existing files by filename. A dialogue box entitled Recall ECG Files will appear, from which the user can select or enter a file name. This is not the recommended method for retrieving ECG recordings because no patient information is provided until after the recording has been opened. Typically it is used to access a file that is not located in the normal ECG recordings directory.

Retrieve Patient(s)...xe "Retrieve: Patients"
Displays The Patient Indexxe "Patient Index" and allows the user to select one or more ECG recordings for display. This is referred to as the normal method for retrieving ECG recordings because the user selects from a list of alphabetically sorted recordings by their patient name. This is the same as clicking on the Retrieve Button on the Tool Bar.

Save
Allows the user to save the ECG recording, including all the markings and patient information. This is the same as clicking on the Save Button on the Tool Bar.

Print
Prints the contents of the screen to any windows supported printer. This is the same as clicking the Print Button on the Tool Bar.

Print Setup
Allows the user to select the type of printer and configure the settings on the printer.

Send ECGs
Allows the user to send one or more ecgs remotely using Microsoft Mail.

Patient Details
Displays the Patient Details and allows the user to view patient details or modify certain details. Doctor’s Comments may also be entered within this window. This is the same as the Patient button on the Tool Bar
Measure
The Measurement Panel
 will be displayed which assists the user in making measurements on the current ECG trace from which calculations and diagnostic indications are derived and displayed. This is the same as the Measure button on the Tool Bar. see also the Measurement Panel
 for a detailed description.
Interpret/Diagnose
Allows the user to obtain an automatic interpretation/diagnostic for the currently open ECG file
Compare
If there are a two or more ECG recordings open for the same patient, this function allows for all the traces to be displayed on the screen one lead at a time for comparing. This is the same as the Compare buttonxe "Compare: Button" on the Tool Bar. See also Compare Mode for more information.
Exit
Closes the CT200 PC Link Utility program.
The Edit menu

xe "Menus: Edit"
All the copy functions that are described in this section place information on the windows clipboard. This information may be accessed by other windows applications. To learn more about the windows clipboard please refer to your windows manual or the windows on-line help for more details about cut & paste operations between applications. 

Copy
Will copy the currently selected information to the windows clipboard from which the user may paste this information into another application. There are a number of different ways for selecting information in CT200 PC Link, they are:
· Selection rectangle, which is drawn in the Lead display window by using the mouse, simply click, drag and release the mouse button. You will notice that a part of the screen will be in a different colour. This coloured section is the selected information.

· By clicking on any one of the tables in the Measurement Panel will select all the contents of the table.

· By selecting the desired text from the Indication Windows using the mouse to click and drag and highlight the displayed text.
Copy all Traces
Will copy all the leads on display to the Clipboard. It is not necessary to make a selection rectangle.
Copy all Tables
Copy all the measurement tables to the Clipboard.
Copy Patient Details
Copy the Patient Details to the Clipboard.
Copy Indications
Copy both the Appendix B - Flagged Findingsxe "Flagged Findings" and the Appendix C - Diagnostic Indication Rules
 on to the Clipboard.
Clear All Marks
Clear all the markings on all the leads for the current recording.

Clear Current Marks
Clear all the markings for the current measurement edit window. This options is only available when in Measurement mode and edit is on.
The Record menu

xe "Menus: Record"
Start
Begin recording new ECG data from the CT 200. This is identical to clicking on the Record Button on the Tool Bar.

Stop
Stop recording new ECG data. This is identical to clicking on the Record Button on the Tool Bar, while recording is in progress.

Link Check
Ensures that the CT200 PC Link Utility can talk to the CT200 correctly (installation check).
The Options menu

xe "Menus: Options"
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Figure 2 - Serial port selection
Comm port ...
A window is displayed which allows the user to select which serial port will be connected to the CT200. see Figure 2
Print Cal Pulse
Toggle the Print Calibration Pulse on and off. If checked, a calibration pulse will be printed at the beginning of each lead on the printout.
Print Grid
Toggle Print grid on and off. If checked, a grid will be printed on the printout.


Both of the above Print settings are defaults that may be overridden at the time of printing. They are meant to be used with Save Options to adjust the default behaviour of the printout.

Colour Settings
Allows the user to configure the colours used in the Lead Display Window(s), for the background, Leads, Grid, Markings and Lead Names. Use Save Options to retain the colour changes for future use.

Language
Allows the user to configure the language for the Automatic Interpretation/Diagnostic result. See Automatic Interpretation/Diagnostic for more details.
Save options
Save the current settings as default settings. The next time you start CT200 PC Link Utility it will use these settings.

The Display Settings menuxe "Menus: Display Settings"
Size: 
5, 10,20 mm/mV - Duplicates the function of the Size Button on the Tool Bar
Speed:
12.5, 25, 50 mm/sec
- Duplicates the function of the Speed Button on the Tool Bar
Filter:
On, Off - Toggles the PcLink smoothing filter.
Format
3,6,12 Channel - Duplicates the function of the Channel Button on the Tool Bar.

Time Offset
Provides a way of manually adjusting which portion of the lead data is displayed. See also Controlling the Time Offsetxe "Time Offset:Controlling".
The Window menu

xe "Menus: Window"
Displays a list of open recordings. The user can click on any recording in the list to move to that recording. This is functionally the same as using the Page Left/Right Buttons on the Tool Bar.
The Help menuxe "Menus: Help"
Allows the user to access the CT200 PC Link On-Line Help.

Contents
Opens the Starting page of the On-Line Help for the CT200 PC link program.

Search
Opens a Search dialogue box that is common to all Windows On-Line Help. A user can type in a word or words and the Search panel will display a list of topics that can be selected.

Help on Help
This will take the user to an On-line help document that teaches the user how to use On-Line Help. There is a standard way of navigating through On-Line help in Microsoft windows.

About
Displays the About dialogue box which shows general information pertaining to the current version of CT200 PC Link Utility.

Context sensitive help
Like most Windows On-Line help, the CT200 PC link help is context sensitive. If the user hits the F1 button on the keyboard, help will display which is relevant to the currently open window or panel. For instance:

If the user in the Patient Indexxe "Patient Index", then clicking on F1 will bring up Help on the Patient Index.

If the user selects the Diagnostic Indications window then pressing F1, the On-Line Help will display the Appendix C - Diagnostic Indication Rules

The Tool Bar
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The functions that are most frequently used are placed on the Tool Bar. All the functions have equivalent items in The Menu Bar.

The Exit Buttonxe "Tool Bar:Exit"
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Clicking this button will close CT200 PC Link.
The File Close Buttonxe "Tool Bar:Close"
[image: image57.png]



Clicking this button will close the currently open ECG file.

The Retrieve Buttonxe "Tool Bar:Retrieve"
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This button displays The Patient Indexxe "Patient Index" which displays all existing recordings in patient name order. The user can select one or more recordings for the same patient to be opened for display. This is the same as clicking on Retrieve Patient(s) in the File Menu. See also The Patient Index for a detailed description.

The Save Buttonxe "Tool Bar:Save"
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Clicking this button will save the currently open ECG file.

The Print Buttonxe "Tool Bar:Print"
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Prints the Leads currently on display. See also Printing



The Record Buttonxe "Tool Bar:Record"
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The Record buttonxe "Tool Bar:Record" starts and stops a recording. Normally a user does not have to stop a recording because the recording ends after all leads have been downloaded. See also Making an ECG recording with the CT200.
The Lead Control Buttonsxe "Tool Bar:Lead Control"
The Size Buttonxe "Tool Bar:Size Button"
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The Size Button is used to control the vertical scale of the traces to be 5,10 or 20 mm/mV. The Size button can take one of three forms    

                                           
to display the current setting.

The Speed Buttonxe "Tool Bar:Speed Button"
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The Speed Button is used to control the horizontal scale of the traces to be 12.5,25 or 50 mm/sec. The Speed button can take one 

                                           
of three forms to display the current setting.

The Channel Buttonxe "Tool Bar:Channel Button"
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The Channel Button is used to control the organisation of the Leads in the trace. These buttons format the leads into 3 channels (3x4), 6 channels (6x2) and 12 channels (12x1) formats respectively. Note that 3 channel format is considered the major format because it displays the rhythm lead which in turn displays the Time offset and allows the user to change the Time offset. See also Controlling the Time Offsetxe "Time Offset:Controlling".
To make a change to one of the above three Lead Control Buttons, click on the button to cycle through the three possible settings for each.

Notes on the Channel display:

In 3 channel format only a small section of each lead is displayed. The rhythm lead (Lead II) is however displayed in full and the section of the trace on display in all the leads above is highlighted. The start of the highlighted sections indicates the Time offset used to display the other leads. The width of the highlighted section indicates the amount of the full trace on display in the other leads. It is possible to change the Time offset by dragging the highlighted section along the rhythm lead.

See also Controlling the Time Offsetxe "Time Offset:Controlling"
In 6 and 12 channel formats, there is no rhythm lead to display and control the Time offset. It is important to realise that the leads are still displayed using the current Time offset. To change the Time offset the user can either use the Time Offset ... Menu item in Display Settings or switch back to 3 channel format.
The Patient buttonxe "Tool Bar:Patient"
[image: image71.png]



The Patient buttonxe "Tool Bar:Patient" displays the Patient Details dialogue box. Apart from the basic demographics of a patient, various comment fields are also presented. See also Patient    

           Details  for a detailed description.

The Compare buttonxe "Tool Bar:Compare"
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This button enters and exits Compare mode. In Compare mode one lead from each open recording is displayed. When in compare mode, this button is shown depressed. To exit compare mode, click on the button once again. Clicking on the Measure button             will also exit Compare mode. See also Compare Modexe "Compare: Mode" for a detailed description.
The Measure buttonxe "Tool Bar:Measure"
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The Measure buttonxe "Tool Bar:Measure" opens and closes the Measurement Panel
. If the Measurement panel is open, this button will be shown depressed. To close the Measurement panel click on the Measure button once more. Clicking on the Compare buttonxe "Compare: Button" will also close            the Measure panel. The Measurement panel shows the calculations that are derived            from the markings made on some of the leads, and also allows the user to make the            markings. See also the Measurement Panel  for a detailed description.
The Interpret/Diagnose buttonxe "Tool Bar:Interpret/Diagnose"
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The Interpret/Diagnose buttonxe "Tool Bar:Interpret/Diagnose" when used performs an automatic interpretation on the currently selected open ECG file. After a few seconds the lower part of the screen will display the interpretive result. See also the Automatic Interpretation/Diagnostic  for a detailed description
Note: Use of the Automatic Interpretation/Diagnostic function requires that an Interpretive CT200 ECG recording device or CT200 component upgrade be purchased. ( Contact Macquarie Medical Systems for more details )

The Page Left/Right Buttonsxe "Tool Bar:Page Left/Right"
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These spin buttons only have an effect if more than one recording is open. It enables the user to move through the recordings one at a time, when Compare Modexe "Compare: Mode" is off. When Compare mode is on, these buttons change the currently active recording. The Title bar of the active recording is always highlighted. The same effect can be achieved in the Window menu. 

The Help Buttonxe "Tool Bar:Help"
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The help button will bring up the CT200 PC Link online help.
Using the Toolbar:  

If you are in doubt or have forgotten the function of a button on the Tool Bar place the cursor over the button and in a second its name/function will be displayed over it.

Note:
If Compare mode is on and  the user clicks on the Measure button, the recording that is displayed is the active recording. In a similar fashion, when the user clicks on the Patient button, the Patient details that are presented belong to the active recording. When printing in compare mode, the Patient details of the active recording are printed.
The Lead Display Window(s)

The Lead Display Window(s) is where the ECG recording(s) is(are) displayed on the screen. If an ECG has been loaded from file or recorded(see Making an ECG recording with the CT200), ECG leads, it will be displayed in this window. The Lead Control Buttons on the Tool Bar control how the leads are displayed.

Depending on the Size and Channel settings, not all the leads will fit in the Lead Display window. When this happens, a Vertical scroll bar appears on the right hand side of the Display panel.

There are 3 modes that the Lead display window(s) can be in:

Channel mode
In this mode all the leads for one recording are visible.

Edit Modexe "Edit: Mode"
One or two Leads in a recording are displayed in close up ready for the editing of the marks. See also Marking out Leadsxe "Marks: Marking out"
Compare mode
One lead for each recording that is currently open is displayed in a separate window. From 2 to 6 windows will display depending on the number of open recordings. See also Compare buttonxe "Compare: Button"
Selecting a lead for Detailed Measurement

By double clicking on one of the leads on display, the user can enter the Detailed Measurement panel.

This panel displays one lead in detail. It allows the user to:

· Traverse a whole lead 

· Magnify the Lead as desired.

· Make standard Measurements and calculations.

· Make manual measurements.

· Print a single lead as it appears on the screen ie current magnification and Time Offset.

For further details see The Detailed Measurement Panel



Controlling the Time Offsetxe "Time Offset:Controlling"
When the Lead Display Window is in Channel mode and in  3 Channel formatxe "Channel Format", only part of each Lead can be displayed at any one time, except for Lead II ( also called the Rhythm lead) which is displayed in full at the bottom of the window. The Rhythm Lead always has a highlighted section to denote which part of the recording (9 seconds) is being displayed on all the other leads. The highlighted section shows the Time offset from the beginning of the recording and also provides a convenient method of adjusting the Time offset:

To change the section of the recording being displayed in 3 Channel formatxe "Channel Format".

1. Locate the mouse pointer on the left hand side of the highlighted section of the Rhythm lead. The mouse pointer will turn into an East-West pointer.

2. Click the left hand mouse button and hold it down, then drag the mouse pointer left or right along the trace to the part of the recording to be displayed. While you are dragging the mouse pointer a vertical bar indicates the dragging operation.

3. Release the mouse button. The display window will re-display using the new Time offset.

This method of changing the Time offset is only available in 3 channel format. The Time offset can also be changed in the Display Settings Menu. Simply enter the Time offset in seconds.
The Measurementxe "Measurement" Panel
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To open the Measurement Panel, click on the Measure button. A panel will display, showing several tables grouped together underneath some buttons. On the right is an area titled Flagged Findingsxe "Flagged Findings" & Diagnostic Indicationsxe "Diagnostic Indications". This area is used to display Diagnostic Indications based on the measurements made on the Leads. 

The Measurement Buttonsxe "Measurement:Making Measurements" 
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The five Buttons on the left labelled Lead II   P.Q.R.S, Left Ventricle, Right Ventricle, Right Atrium, Left Atrium denote the five major groups of Measurements and are called Measurement buttons. When a user clicks on one of these buttons, the Lead(s) required to make the measurements associated with the button are displayed in detail (Close up). This is called the Edit Modexe "Edit: Mode".
In Edit  mode, the right hand side of the Measurement panel displays a Red waveform with buttons positioned along the waveform. The buttons on the waveform indicate which points on the Lead(s) should be marked out. These buttons are called the Mark buttons.

The Edit Control bar  displays on top of  the Measure Panel. This bar has:

· The lead name or lead names currently being edited

·  A Scale control which displays the current magnification of the display and allows the user to change it by clicking on the left/right buttons.

· A horizontal scroll bar which is used to move along the trace. Note that changes made using this scroll bar change the Time Offset for the current recording.

On the right hand side of the Lead Display window is a Vertical scroll bar that is used to centre the lead(s) on display.
The Calculation Boxes and the  Indication windows

The calculation boxes display the most frequently used calculations. A calculation will highlight in Red if it is out of range (minimum and maximum value). Out of range calculations are detailed in the Flagged Findingsxe "Flagged Findings" window. In edit mode the Indication windows cannot be seen. 

The Diagnostic Indicationsxe "Diagnostic Indications" analyse the out of range calculations for a series of standard diagnoses:

· Long pause
· Bradycardia (Heart Rate < 60 BPM)

· Tachycardia (Heart Rate > 120 BPM)

· ST Iso electric elevated or depressed
· Left Ventricular Hypertrophy
· Right Ventricular Hypertrophy
· Right Atrial Hypertrophy
· Left Atrial Hypertrophy
· Left Bundle Branch Block
· Right Bundle Branch Block
· No P Wave  .... Possible Ventricular ectopic beat

· No P Wave  .... Possible Atrial ectopic beat

· No P Wave  .... Possible Supra Ventricular ectopic beat

Note:

The Diagnostic Indications given via the use of manual measurement are based on a few simple rules and should be treated as suggestions only. See also Appendix C - Diagnostic Indication Rules
.

For a more thorough and reliable diagnosis we recommend the automatic interpretation as given from using the Interpret/Diagnose Button.

See also the Automatic Interpretation/Diagnostic  for a detailed description
Marking out Leadsxe "Marks: Marking out"
1. Enter the Measurement panel by clicking on the Measure Button.

2. Click one of the Measurement buttons ( Lead II, Left Ventricle, Right Ventricle, Right Atrium, Left Atrium). The following changes will occur:

· The lead or leads associated with this button will display in close up.

· The selected button will highlight in Red.

· One or two red wave forms will display on the right hand side of the Measurement panel. These are symbolic diagrams are intended to indicate where to mark on the actual Lead(s). 

· The Left most Mark button will highlight, to indicate this is the current point.

· The Edit control bar will display on top of the Measure panel.

1. Notice which mark button is highlighted and use the mouse to make this mark on the actual lead by clicking with the left mouse button. Notice that the mouse pointer turns into a Cross Hair when the pointer is on the Lead. A mark cannot be made until the pointer turns into a Cross Hair. The mark will display as a vertical bar on the lead.

2. If the next mark in the sequence of marks to be made is empty, the highlighted button will increment to the next position. This means that on a lead that has no previous marks, the user can simply enter the marks one after the other. This incremental process stops when the next mark in the sequence has already been entered.

As marks are entered the calculations that use these marks are filled out. In some cases a given mark will affect more than one calculation. Any calculation that uses a given point will be updated when the point is entered for the first time or when subsequently moved.
Modifying existing Marksxe "Marks: Modifying"
When a point (mark) is already entered, it can be adjusted by clicking on the associated Mark button and clicking on the point on the trace where it should be. The old mark will be moved to the new position. Note that the Mark button does not move onto the next position under these conditions.

Tips:
· It is easy to get confused when editing existing marks. Always refer to the Mark button first to see which one is highlighted. Be sure the cycle you are marking on the Lead is the same as the cycle on the Red wave form.

· Before starting to make measurements adjust the Time offset to the beginning of the first cycle to be measured.
Exiting Edit Modexe "Edit: Exiting Edit Mode"

xe "Edit: Mode"
To return back to the channel display click on the Measurement button that is highlighted in Red ie the button that was selected to enter the current Edit cycle. The Red Wave form will be replaced by the Indication Windows. It is also possible to view the Indication windows without returning to the Channel display by clicking on the Edit ON OFF radio buttons.

Closing the Measurement Panel

Click on the Measure button on the Tool Bar at the bottom of the screen. ie This is a toggle button, clicking turns the measurement panel on and off. Clicking on the Compare buttonxe "Compare: Button" will also close the Measure panel.
Compare Modexe "Compare: Mode"
When the user enters Compare mode by clicking on the Compare buttonxe "Compare: Button", 2 or more recordings will display ( up to a maximum of 6 recordings ). The Compare Control barxe "Compare: Control bar" will also display at the bottom of the screen.
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The Alignment buttons on the left of the Compare Control barxe "Compare: Control bar" allow the user to select how the leads are aligned. The Choice of P, Q, R, S, T represent the major features of a trace. The alignment will only work on recordings that have had Lead II marked out in advance. When this is the case, a vertical bar will display indicating where the alignment is being made. Where there is no vertical bar on display, the recording has not been marked out. Note that alignment always operates on Lead II measurements even when Lead II is not the Lead on display.

 The Lead selection buttons  are on the right hand side of the Compare Control barxe "Compare: Control bar". These up/down spin buttons allow the user to change the current lead on display in Compare mode.

Other Details:
If only one recording is open when the user clicks on the Compare buttonxe "Compare: Button", the compare mode function will automatically try to retrieve the last two recordings prior to the current recording. If there are no previous recordings nothing will happen.

If there is already more than one recording open, Compare mode will not try to Retrieve prior recordings and will simply display the recordings that are currently open.

When the user selects more than one recording in The Patient Indexxe "Patient Index", the application will automatically enter Compare mode.

The user can exit Compare mode by either, clicking on the Compare buttonxe "Compare: Button" once more, or clicking on the Measure button. In either case, currently active recording will be the one recording that will display in Channel formatxe "Channel Format". The user can select the currently active recording by:

· Clicking on the Window menu and then clicking on one of the recordings in the Window List.




OR

· Clicking any where in the Window containing the recording.




OR

· Using the Page control buttons on the Right hand side of the Tool Bar.

In all cases the user will see the Title bar highlighted on the selected recording.

When printing in Compare mode, the Patient details for the currently active recording will be printed out.

The Detailed Measurementxe "Measurement:Detailed Measurement" Panel
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This window  is what the user sees after double clicking on one of the leads in the Lead Display Window. If the lead has been measured before, there will be vertical marks at the points that have been measured. The 3 cycles referred to by the Cycle radio buttons and the 

Calculation Tables are 3 consecutive cycles of the lead on display.

Making Standard Lead Measurementsxe "Measurement:Standard Lead Measurements"
When first displayed the Cycle Off radio button will be selected, indicating that Measurement mode  is off. Take the following steps to enter measurement mode and commence measurement:

1.
Click on the Cycle 1  radio button.

2.
Click on the first radio button in the Point Selection box.

3.
Use the mouse to click on the Lead drawing to mark the point corresponding to the point selection made in step 2. The mouse pointer should change into a crosshair symbol when the mouse pointer moves into the Lead drawing area. A vertical mark will display at the point you clicked on the lead. Notes: 

SYMBOL 183 \f "Symbol" \s 10 \h
Accuracy in the vertical axis is not required because the point is always positioned on the lead.

SYMBOL 183 \f "Symbol" \s 10 \h
The selected radio button in the Point selector box moves onto the next point if that point has not been marked before ( the point is empty ). If the current point is the last point, the next point becomes the first point, and the current cycle is incremented. In this way the user is incremented through all 3 cycles of measurement.

4.
Continue marking points on the lead corresponding to the current point and current cycle. As points are marked out you will see the calculation tables filling out. After measuring two cycles the Heart Rate will be displayed.

5.
Exit measurement mode by clicking on the Cycle off Radio button. Notice that when the mouse is moved into the Lead Display area, the pointer does not change into a crosshair. It is important to exit Measurement mode when not in use because it is very easy to make an accidental measurement which will immediately effect the calculations.

Editingxe "Measurement:Editing" Existing Measurement Points

1.
Select the required cycle and point radio buttons. Notice that a small square is displayed immediately above or below the corresponding point marker.

2.
Click the mouse pointer at the new position for the mark. You will see the mark move to this new position. Notice that the current cycle and point radio buttons remain unchanged. You will see some of the table calculations change as well.

3.
Exit Measurement mode by clicking the Cycle off radio button.

Making a Manual Calculationxe "Measurement:Manual Calculation"
The Manual Calculation box will display the Horizontal and Vertical difference between two points marked on the Lead. The same user interface is used as in the Standard measurements. Note that Manual  measurements are not saved to file.

1.
Click Radio button 1 in the Manual Calculation box.

2.
Mark the point on the Lead. A mark will display where you have clicked. Notice that the Radio button will move to Point 2 if it was previously empty.
3.
Mark the 2nd point on the Lead. The manual Calculation box will display the Horizontal and Vertical difference between the two points in seconds and millivolts.

4.
To make changes to a manual point, select the point you want to change, then click with the mouse in the lead Display area the new position.

5.
Click the Cycle Off radio button to exit Measurement mode.

Controlling the Lead Display

A user can control the Time Offset, Vertical (millivolt) offset and the Zoom factor by the use of the Time Offset, Vertical Offset and the Zoom Scroll bars  respectively.

There are 3 ways to control a scroll bar:

1.
Click on one of the arrows at either end of the scroll bar to make a small change.

2.
Click on either side of the square scroll bar button to make a large change.

3.
Drag the scroll bar button by clicking and holding down the left mouse button while moving the mouse pointer to a new position on the scroll bar.

The squares of the grid represent 5 mm on standard trace paper. The Scales Menu allows the user to select from a set of standard Trace speeds and sizes that effect the way that the Lead is displayed.

Making an ECG recording with the CT200

Initial setup

1. Connect the CT200 to the PC through the PC cable (Male to Female) via one of the serial ports on the PC (usually COM2). 
2. In the Options menu, select the COM port that the CT200 is connected to.
3. From the Comm menu select Link Check. This will test the link between the two machines ( This step is optional ).
To make a recording for a new Patient:

1. Click on the Record button on the Tool Bar. After a few seconds, a progress bar will appear at the bottom of the screen. 
2. After some processing, the lead data will display along with an empty Patient Details panel. Details entered here will be saved along with the Lead data. If the recording is for an existing Patient click on the existing Patient button to bring up the Patient index where you can select the existing patient and copy the details into the new recording. It is still possible to edit the copied details.
To make a recording for an existing Patient:

There are two methods for doing this:

Method 1:

1. Retrieve the existing Patient, by Clicking on the Retrieve button and selecting one or more recordings for the existing patient.

2. Click on the Record button. The application will ask the user if the recording is for the existing patient. Click on Yes.

3. The recording will proceed and when complete the Patient Details dialogue box will display with the details for the existing patient already filled out.

4. The user can then modify the details, especially the Doctor’s name, Cardiologist’s name and the comment fields which are likely to change from recording to recording.

Method 2:

1. If existing recordings are open the user will be asked if the recording is for the existing Patient. Click on No. This will close all open recordings.

2. The recording will proceed and when complete the Patient Details Dialogue box will display. It will be empty.

3. Instead of entering the details by hand, click on the Existing Patientxe "Patient Details: Existing Patient" Button.

4. The Patient Indexxe "Patient Index" will display allowing the user to select one recording from which to default the Patient Details from.

5. The user can then modify the details, especially the Doctor’s name, Cardiologist’s name and the comment fields which are likely to change from recording to recording.

6. (Optional) Click on the Compare buttonxe "Compare: Button". The Application will automatically open and display the last 2 recordings for the Patient, so that Compare mode will show 3 recordings.

Problems with recording on to the PC:

· Persistent TimeOut errors indicate no data is getting through at all. Check the connection between the CT200 and the PC. Check that the CT200 PC link program is using the correct Communications Port (COM1, COM2).

· Frame error, Data lost, Parity error and Input buffer overflow are error messages that indicate serial communication problems. Possible causes of these problems are:
a) The computer is too slow and can’t keep up. (unusual)

b) The COM port cannot keep up with the rate of data being sent. A new serial card may be required. When purchasing such a card specify that serial ports use the 16550 chip or compatible. These are commonly available and quite cheap Note that the CT200PC sends information to the PC at 19200 baud which is quite fast.

c) The computer is short of resources. This can happen if there is not much RAM available, especially when another large program is already loaded or running (eg MS Excel, MS Word). This can be tested by looking in the Program Manager Help menu ... About Program Manager menu item. The About dialogue box will give % system resources. If this value falls below 50%, this can be a problem. Closing other applications and or exiting out of Windows can assist with this problem.

Printing

The Print buttonxe "Tool Bar:Print" allows the user to print various formats according to the current screen layout. Note that the current Time Offset is used to print the Leads . If the Measurement panel is in view its contents will be printed. Some formats are not printable because they do not fit on one page. The layout is designed for A4 stationery. 

The time it takes for printing to start varies from printer to printer. Laser printers offer a number of options which should be explored for best results. Try using the postscript option if available.

If you are using a Hewlett Packard Printer, they frequently come with a diskette containing Windows printer drivers. These drivers are better than the drivers that come with MS Windows 3.1x and are well worth installing.

If you have problems with the Text in the calculation tables not centering properly, see if there is a True Type font option in the printer driver, this will often fix the problem.

The Patient Indexxe "Patient Index"
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The Patient Indexxe "Patient Index" is accessed from the File menu, Retrieve Patient(s) ... menu item or the Retrieve Button on the Tool Bar. The user can select one or more recordings by clicking on the row for each recording, then open the recordings for display by clicking on the Open File(s) button. 
The Patient Indexxe "Patient Index" operates in two modes, UnLinkedxe "Patient Index: UnLinked" and Linkedxe "Patient Index: Linked" respectively. These modes are described below:

UnLinked ( No recordings previously open )

In this mode it is possible to search for a patient’s recordings by entering part of the name in the Search for Patient field. eg. If the user types in W then all patients starting with W will display. If the user then follows this with an I all patients starting with WI will display. If the user then deletes the I, the display will go back to displaying all patients starting with W.

Align Patient Detailsxe "Patient Index: Aligning Patient Details" 

In situations where recordings for the same patient have different patient details, this function is provided to align them. This function only aligns the Name, Date of Birth, Sex, and ID fields. 

To align patient details:
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1. Select a group of recordings that should have the same patient details. 






2. Click on the Align Patient Detailsxe "Patient Index: Aligning Patient Details" button. A number of new fields will appear below the Patient Index that allows the Patient details to be altered

3. Click on the row with the most correct Patient Detail information. The details in this row will appear below in the edit fields.

4. Optionally modify the Patient Detail information. 
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1. Click on the Accept button. All the selected records will now share the same Patient detail information.





















2. To stop an alignment operation use the Cancel button.

Archived Patient Index xe "Patient Index: Archived Patient Index" 

As the amount of ECG recording files increases in the Patient Index over time, the speed of opening or rebuilding the patient database reduces. It may be more efficient to archive elsewhere some files which do not need to be accessed with your most recent files.

An archive function is provided to move ECG recording files with a status of B ( for Back ) or O ( for Old) to an Archived Patient Index.
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To Archive status B or status O ECG recording files, use the Archive Button. 

View Archived ECGs:


[image: image87.png]



To view archived ECGs use the View Archived ECGs Button. This function switches from the Patient Index to temporarily display the Archived Patient Index. Most of the functions available when using the Patient Index are also available for use on ECG recording files from the Archived Patient Index.

When the Archived Patient Index is displayed, click on the View Archived ECGs Button again to return to the Patient Index.

Maintenance Menuxe "Patient Index: Maintenance Menu"
These menu items can only be accessed when there are no open recordings in the main module (unlinked mode).

Delete Selected Recordings

1. Select the recordings to be deleted.

2. Click on the Maintenance menu in the Patient Indexxe "Patient Index".

3. Click on Delete Selected  Recordingsxe "Recordings"  in the Maintenance Menuxe "Patient Index: Maintenance Menu". A message box will pop up to confirm that the user wants to delete.

Rebuild Patient Indexxe "Patient Index". 
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Rebuilds the Patient Index based on the ECG files found in the default ECG directory (C:\CT200\ECGS). If the user feels that recordings are missing from the Patient Index then using this function will check that the database patient details match the patient details saved in the files that exist in the ECG directory of the computer’s hard disk. This function is duplicated by the use of the Rebuild button in the Patient Index.

Status Legendxe "Status Legend". 

The Status Legend displays the meaning of each of the one letter symbols in the Status column of the Patient Index. The Status of the ECG recording reflects the life cycle of the ECG recording when using the Send ECG function to mail an ECG recording to a remote diagnostic centre for expert analysis.

See also the Send/Mail ECG(s)  for a more detailed description

Mail Menuxe "Patient Index: Mail Menu"
Send Selected Files ...
Send selected ECG recording(s) to the previously selected mail recipient. This is identical to clicking on the Mail Button on the Tool Bar.

Select Recipient...
Allows the user to setup or change the mail recipient.

For further details See Send/Mail ECG(s)
Linkedxe "Patient Index: Linked" Mode( One or more Recordingsxe "Recordings" previously open ).

In this mode the index will only show recordings with the same Patient Name as that of the opened files. It is not possible to30 change the text in the Search for Patient field. The files that are open will already be selected and cannot be deselected. A user can only select other files to be opened.
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The Patient Indexxe "Patient Index" in Linkedxe "Patient Index: Linked" Mode. The Search Name is locked and the currently open recording is already selected.
Summary of rules relating to the Patient Indexxe "Patient Index":

1. The maintenance functions, Delete, Rebuild and Status Legend xe "Patient Index: Changing Directory" can only be accessed in UnLinkedxe "Patient Index: UnLinked" mode.

2. Only recordings for the same Patient can be loaded from the Patient Indexxe "Patient Index".

3. The criteria used to check for sameness is Patient name and Date of Birth.

Patient Details


[image: image90.wmf]
Click on the Patient button on the Tool Bar to open the Patient Details Panel. Details entered in this panel will be saved to the ECG file and will also appear on the Print out.

It is recommended that the Patient’s name be entered Surname first, to comply with accepted standards.

The format of the DOB (Date of Birth) field is fixed as day/month/year. See also Appendix E - Date and Time Formatsxe "Date and time formats" at the end of the manual for further details.

After making a new recording, the Patient Details Dialogue Box pops up. Instead of entering the patient details by hand, the user can:

1. Click on the Existing Patientxe "Patient Details: Existing Patient" button which then displays the Patient Indexxe "Patient Index".

2.  In the Patient Indexxe "Patient Index" find the recording to copy Patient details from and select.

3. Click on the Acceptxe "Patient Details: Existing Patient" Button. The details will now appear in the Patient Details dialogue box.

4. Modify the details as required. The Doctor’s name , Cardiologist’s name and the text comment fields  should always be reviewed.

It should be noted that where ever possible, the user should make an effort to check that the patient has no previous recordings, and use this function where ever possible. The operation of Compare Modexe "Compare: Mode" depends upon the exact matching of the Patient’s name and Date of Birth with the same details in other recordings.
Send/Mail ECG(s)

Through the use of a modem connected to the computer or via a network, the ECG recording file may be transmitted electronically to another computer user, such as a licenced Macquarie Diagnostic Centre for a remote ECG referral service.

Contact Macquarie Medical Systems to find out details on how to use this service.
The Send/Mail ECG(s) function currently relies on using Microsoft Mail Ver 3.5 for MS Windows 3.11., and it requires that it be previously configured for normal operation. Consult your Windows manual for details on this.

The MS Mail application should be started before starting PCLink, and left remaining active

The Send/Mail ECG(s) function may be operated from the Mail menu within the Patient Index 

Selecting the Mail Recipientxe "Send/Mail ECG(s): Selecting the Mail Recipient" 

Firstly ensure a working configuration of a modem or a MS Windows for Workgroups network, and MS Mail exists on your system, and that you can add ‘Microsoft At Work Fax’addresses to your MS Mail Address Book which you can send test messages to.

If this is this case then selecting a Mail recipient should be simple.

If your Mail recipient does not exist in your MS Mail Address Book, then add the address of the recipient into the Address Book as a ‘Microsoft At Work Fax’ from within MS Mail.

Now that the address exists in the Address Book you may use Pclink to select the Mail recipient by entering the ‘Alias’of that Address. This is done as follows.

1) Use Select Recipient... from the Mail menu, to bring up the Mail Recipient Selection dialog box.

2) Enter the ‘Alias’of the intended Mail recipient’into the text field of this dialog box. If you cannot remember the ‘Alias’, use the Address Book button to review the list of addresses. Important: While reviewing the Address Book only use the Close button, to return to the Mail Recipient Selection dialog box, and enter the ‘Alias’into the text field manually.

3) Use the OK button to complete the Mail recipient selection process, or Cancel to abort.

To change the Mail recipient afterwards, use the Select Recipient... from the Mail menu in the same way as just described.
Mailing ECG(s) xe "Send/Mail ECG(s): Mailing ECG(s)"
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To Send/Mail ECG(s) the user can select one or more recordings to mail in the Patient Index by clicking on the row for each recording, then mail the recordings for display by clicking on the Send/Check Mail button.

The ECG File Sending dialog box will display asking the user to conform proceeding with the mailing. Use the Yes button to proceed, or the No or Cancel buttons to abort.

Proceeding with a mailing will automatically result in the attachment of the selected ECG recording file(s) to a single MS Mail message,which is then placed in the MS Mail ‘Outbox’ to be sent.

Status of ECG(s) xe "Send/Mail ECG(s): Status of ECG(s)"
The far right column of the Patient Index displays the Status of each ECG recording file with a single letter symbol. This letter symbol represents the state of the file within the life cycle of mailing a ECG recording file to a Diagnostic Centre for remote referral.
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The Status Legend displays the meaning of each of the one letter symbols in the Status column of the Patient Index, as is shown below.

The first Status a recorded ECG file has is N ( for New ). The first time an ECG recording file is mailed using the Send/Mail function the status will change from N to S ( for Sent ).

Receiving ECG(s) xe "Send/Mail ECG(s): Receiving ECG(s)"
In order to receive mailed ECG recording files, the user is required to manually check the mail by using the Send/Check Mail button in the Patient Index. A dialog box will respond and indicate if any new ECG recording files have arrived.

From the use of a remote referral service, the user may receive their original ECG recording file back from a licenced Macquarie Diagnostic Centre, complete with expert analysis and comments included in the file.

An ECG recording file received that has completed the remote referral service cycle will be indicated by the file having the status B ( for Back ). An ECG recording file received that has not been sent from a licenced Macquarie Diagnostic Centre will still have a Status S (for Sent).
Automatic Interpretation/Diagnostic

Use of the Automatic Interpretation/Diagnostic function requires that an Interpretive CT200 ECG recording device or CT200 component upgrade be purchased. This ad-on comes free with all new CT200 ECG units.
Note: The Automatic Interpretation/Diagnostic function can only be performed on ECG recording files which originate from the above types of CT200 equipment.

To use the Automatic Interpretation/Diagnostic function, use the Interpret/Diagnose button in the Tool Bar to interpret/diagnose the currently selected, open ECG recording file.

In a few seconds the Automatic Interpretation/Diagnostic Panel will appear at the lower part of the screen to display the result. An example of the Auto I/D Panel is shown below.
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This Automatic Interpretation/Diagnostic function is more thorough and reliable than the Diagnostic Indications given by the manual Measurement method, and as such is recommended as the preferred Diagnostic method.

Changing the Automatic Interpretation/Diagnostic result language
To change the language of the interpretive result use the Language function in the Options menu. A dialog box titled “Select a Language” will display a drop down list box of language options which may be selected.

How to get the most out of the Automatic Interpretation/Diagnostic
It is important that the user ensure that good ECG recordings are made as the accuracy of the result of the Automatic Interpretation/Diagnostic depends on the quality of the signal recording.

Although the input signal is filtered, very noisy ECG recordings may still effect the accuracy after filtering.

An important difference can be made with a proper skin / ECG electode connection.

Here a few simple rules to follow to help reduce the effect of noise on the ECG recording.

· a conductive gel must be used.

· do not re-use disposable electrodes

· wait for the Heart Rate displayed on the CT200 LCD to stabilise before commencing a recording.

· ensure good electrical contact exists between the skin and ECG electrodes.

Interpretation/Diagnostic Accuracyxe "Automatic Interpretation/Diagnostic: Automatic Interpretation/Diagnostic Accuracy"
The software module which the CT200 PcLink Automatic Interpretation/Diagnostic is based on has had its performance to interpret ECGs evaluated in an international study detailed in the New England Journal of Medicine Vol 325. No.25.

This study used 1220 clinically validated ECGs to compare the results of nine different computer programs (from U.S.A., Japan & Europe) with eight cardiologists from seven European countries.

To summarise the results of the study, the total accuracy as a percentage was as follows:

Each cardiologist is identified by a number from 1 to 8. and various programs numbered to 16 were tested


Cardiologists
Computer Programs


1

75.3%
   2


69.8%


2

77.11%
   4


75.8%


3

78.3%
   5


69.3%


4

78.5%
   7


67.6%


5

75.5%
   8


65.6%


6

73.8%
  13


69.7%


7

72.6%
  15


69.8%


8

81.0%
  16


77.3%

The CT200 PcLink Automatic Interpretation/Diagnostic incorporates Program 16 in the above table.

These results demonstrate that standard ECG reading computer programs assist clinicians.  However, all MMS ECG printout will always require that the printed interpretation/diagnostic is always validated and signed by a cardiologist for a second opinion.
Real time recording and monitoring for CT200 ECG

RT200 is an add-on program for the CT200 that allows ECG data to be stream direct to the PC’s display. It allows continuous monitoring of either the full 12 leads or a single lead. The ECG can then be saved, retrieved or printed.

Installation note

RT200 is a full 32-bit Microsoft Windows application that runs on Windows 95 or better. To install RT200, click on the START icon, then RUN, then enter the following; ‘A:Setup.exe’.Then click OK. Alternatively, you can open up MY COMPUTER from your desktop, then double click on the A: DRIVE icon, then double click on the SETUP file in the A drive folder. If any system DLL files have been updated, you may will be prompted to reboot the computer.

Running RT200 for the first time
RT200 will look similar to the one as shown below: 

Before you can record any ECG, you need to select and verify the communications. Click on the  Set up button or click on the Menu bar Edit – Options.


Confirm the communication by clicking on the Links check button. The other tabs ‘Display/View’ allows you to select the colour scheme and the “Print/Export” allows you to customise the printing options for various printers. You should try different options for the best results for your printer.

Digital real time filtering

On a very noisy recording environment, it is possible to enable the real time digital filtering option to remove high frequency interferences:
By setting the filter to 40Hz, most high frequencies above 40Hz including powerline and muscle
artifacts would be removed. Note that this setting is actually the "Exercise ECG" bandwidth and normally
not used in clinical diagnostics. It is recommended to improve the recording environment than using the lower filter setting.

The real time filtering requires a fast computer to perform the calculations. Only enable this option if you have a PC with Pentium Celeron 433 Mhz or better.

Appendix

Appendix A - Standard Measurementsxe "Measurement: definitions"
Measurements are divided into horizontal (seconds) and Vertical (mm). In the Measurement Panel
 the two tables underneath the Lead II contain the standard measurements of a Lead. These Measurements are the same for all leads in an ECG.

Referring to the diagram below ...
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Horizontal measurements 
Points
Units

P duration
3  -   1  
secs

PR interval
4  -   1  
secs

QRS
8  -   4  
secs

ST segment
9  -   8  
secs

ST interval
11 -  8  
secs

QT interval
11 -  4  
secs

Cycle Length
13 -  4 
secs

QTC
QT interval

( (Cycle length)


Heart Rate 
 1/ Cycle length        
Beats/Minute

Long Pause
15 -  14
secs









Vertical measurements
Points
Units

P
2  -   1
mm

QR
6  -   5
mm

RS
6  -   7
mm

T
10 -  9
mm

ST Isoelectric
Avg (8, 9) -

Avg(11, 12)
mm









Comments

QTC 
requires at least 2 cycles to be measured. Thus it can only be calculated on the 2nd cycle.

Long Pause
Is a measurement that only has significance when there is a break in the regular cycle of an ECG. The user should arrange the first and second cycles so that they coincide with the last regular beat. The 3rd cycle should be the start of the “paused” cycle.

ST Isoelectric
Compares the average height (mm) of the ST segment  with the average height of the inactive portion of the cycle.
See also
 Appendix B - Flagged Findings

Appendix C - Diagnostic Indication Rules

Appendix B - Flagged Findingsxe "Flagged Findings"
Each Row in the Calculation tables has an associated maximum and minimum valid range. When values are outside the valid range they are highlighted in Red on the screen and printed in Bold on the printer. Some of the out of range conditions also trigger Diagnostic Indication. 

See also 
Appendix A - Standard Measurements
 and Appendix C - Diagnostic Indication Rules
xe "Measurement: definitions"
Note that some of the maximum values are set so high that they will never trigger an Out of Range condition.

Lead II Complexes
Lead II (sec)
Min (sec)
Max (sec)

P duration
0.07
0.12

PR interval
0.12
0.20

QRS
0.07
0.10

ST Segment
0.00
1.00

ST Interval
0.00
1.00

QT interval
0.00
2.00

QTC
0.40
0.44

Lead II (mm)
Min (mm)
Max (mm)

P
0.50
3.00

QR
0.00
50.00

RS
0.00
50.00

T
2.00
20.00

Lead II
Min
Max

ST isoelectric(mm)
-2.50 
+2.50

TP pause(sec)
0.00
2.50

Heart Rate (BPM)
60.0
120.0

Left Ventricle

Left Ventricle
Min (mm)
Max(mm)

RS         V1
0.00
25.00

QR         V5
0.00
25.00

Total [mm]
0.00
35.00

Right Ventricle

Right Ventricle
Min(mm)
Max(mm)

QR           V1
0.00
25.00

RS           V1
0.00
25.00

RS-QR     V1
0.00
50.00

Right Atrium

Right Atrium
Min(mm)
Max(mm)

P              LII
0.50
3.00

P              LIII
0.50
3.00

P              aVF
0.50
3.00

Left Atrium

Left Atrium
Min(sec)
Max(sec)

P duration LI
0.07
0.12

P duration LII
0.07
0.12

P duration aVF
0.07
0.12

Appendix C - Diagnostic Indicationxe "Diagnostic Indications" Rules

The following items describe how the diagnostic indications are made with the manual measurements method, and is not to be confused with the Automatic Interpretation/Diagnostic function. Italic comments indicate calculations that are not made by the CT200 PC link.

See also
 Appendix B - Flagged Findingsxe "Flagged Findings"


Appendix A - Standard Measurements
xe "Measurement: definitions"
1. Long Pause
Based on Lead 2, this calculation is the time between the end of the T wave and the start of the P wave of the following cycle. A long Pause is > 2.5 sec

2. Heart Rate Indications.
Bradycardia 
Heart Rate < 60 BMP 
except for athletes.

Tachycardia       
Heart Rate > 120 BPM

3. ST Iso electric 

Value = Average value of ST Segment (mm) - Average value of Iso electric (mm). Where the Iso electric is measured on Lead II between the end of the T wave and the start of the P wave for a normal cycle ( not long pause ).

Elevated if    Value > 0.25 mm
 

Depressed if Value < 0.25 mm

4. Left Ventricular Hypertrophy
Measure RS on lead V1 and QR on lead V5.

Hypertrophic if either one of these measurements is > 25 mm or the sum of the two is > 35 mm

Some cardiologists prefer to use lead V2 and lead V6 instead of V1, V5.
5. Right Ventricular Hypertrophy
Measure QR on lead V1 and RS on lead V1.

Hypertropic if QR > RS

This is only a gross indication ...

if QR > RS on V1 and the time interval  QS > 0.03 or
 if  QR on lead aVR > 20 mm,  this indicates hypertrophy.

6. Right Atrial Hypertrophy
Inspect P on Lead II, III and aVF

Hypertrophic if  any one of these measurements is < 0.5 mm

7. Left Atrial Hypertrophy
Inspect P duration on Leads I,  II and aVF.

Hypertrophic if any one of these measurements is < 0.07 secs.

If  lead V1 has no P wave,  it is acceptable if other leads show a P wave.

8. Left and Right Bundle Branch Block

Inspect QRS on Lead II..

If QRS > 0.1 sec and there is Left Ventricular Hypertrophy then

if QRS has one peak call it Left Bundle Branch Block

if QRS has Twin peak call it Right Bundle Branch Block.
9. No P Wave
Inspect P  for Lead I, II and aVF

Inspect P Duration for Lead I, II and aVF

For Lead I if P Vert < 0.5 mm or P Dur < 0.07 then 


No P Wave  .... Possible Ventricular ectopic beat

For Lead II if P Vert < 0.5 mm or P Dur < 0.07 then 


No P Wave  .... Possible Atrial ectopic beat

For Lead aVF if P Vert < 0.5 mm or P Dur < 0.07 then 


No P Wave  .... Possible supra Ventricular ectopic beat

Appendix D - Changing VGA mode: (optional)xe "Changing VGA mode"
This version of the CT200 PC Link is designed to run best in Super VGA mode(16 colours 800x600). While it does run in VGA mode, this is not it’s optimum configuration. We recommend that you try this display mode.

To see if you are in VGA or Super VGA mode ...

In the Program Manager find the Main Group, and open it. Here you will find Windows Setup, ...run this application. It will show you what Display mode you are currently using. 

If you are in VGA  mode and want try switching to Super VGA, go to the Options Menu of  Windows Setup and select Change System Settings ... a dialogue box will display which will allow you to make changes.

Click on the down arrow to the right of the Display: settings. A List box will drop down which you can scroll through. You should find in this list, Super VGA [800x600 16 colours] ... click on this selection, then click on OK  to accept it.

If you are prompted to enter a Windows diskette, and these are not available, you can use the CT200PC Installation diskette in it’s place. 

Windows Setup  may ask you if you want to accept the Current driver or install a new one ... accept the Current driver. 

Windows Setup will ask you to Restart Windows ... follow instructions.

You should now be in Super VGA Mode !

You can try other super VGA modes (1024x768), however to use these you will need to install the required driver from diskettes that come with your computer ( they don’t come in Windows itself. In step 3 above scroll to the end of the list of display options and you will find Other Display (Requires disk from OEM)....

Appendix E - Date and Time Formatsxe "Date and time formats"
The format of both the Date of Birth and the Date and Time stamp of the recording are affected by the International settings of Microsoft Windows. The user should adjust the International settings to reflect their locality as best as is possible. 

To make adjustments to the International settings:
The International Settings panel can be found in the Control Panel (Usually found in the Main group).
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Change the Country to the country that best fits your locality. Pay attention to the Date Format, this may be adjusted further by clicking on the Change ...  button. These settings affect how the CT200PC link application receives and displays date and time information.

If changes are made to the International settings while still in the CT200 PC link program, exit out and restart the program for the new settings to take effect.

Appendix F - Troubleshooting Guide: xe "Changing VGA mode"
The following troubleshooting guide is designed to assist the user when faced with some of the more common CT200 portable unit and PCLink problems.

Power
PROBLEM
CAUSE
SOLUTION

The CT200 will not turn on


The battery is flat

The CT200 is faulty
Plug in the plug-pack, and wait a few min​utes for the battery to recover. Make char​ging the unit over​night your no​rmal practice.

Call service

Print Quality

PROBLEM
CAUSE
SOLUTION

Printout is faint or patchy


The paper is the wrong type or poor quality
Use paper supplied (see 

"Or​dering Accessories"). Only use thermal paper

Paper Jam

PROBLEM
CAUSE
SOLUTION

Failure to Print
Printer Fault
Call Service

Electrode Contact

PROBLEM
CAUSE
SOLUTION

Printout is aborted after printing the first lead and a message    'Check lead contact'


No pulse rate detected due to one or more electrodes being disconnected. 


Connect all leads to the patient or connect un​used leads to the RL lead. All the leads must be connected for a good recording.

One or more leads are printed as a flat line with a message

 'Check lead contact'
The lead(s) is (are) disconnected from the patient.  If either of the leads V1,V3 or V6 are disconnected, then all 

three will be affected in

 the printout.
The lead(s) which is (are) disconnected is indicated. 

Connect all leads to the patient or connect un​used leads to the RL lead. All the leads must be connected for a good recording.

Signal Quality
PROBLEM
CAUSE
SOLUTION

The measured pulse rate does not match the rate printed on the recording
The measurement did not reach its final value before the recording started.

The patient moved during the recording or the quality of the recorded ECG was poor.
Wait until the displayed pulse rate is stable before starting a recording.

Check the conditions below. The CT200 may not measure the rate correctly if it cannot "see" a good ECG signal on Lead II.

The quality of the re​corded ECG is poor


The patient's skin is not clean

The suction bulbs or limb straps have built up a residue of gel.

Disposable electrodes have been re-used.

Electrode terminals are loose or in poor contact with the patient leads

Limb straps are loose

The patient moved or spoke dur​ing the record​ing or the patient is tense (not relaxed)

Not enough ECG electr​ode gel has been ap​plied

Disposable electrodes have dried out during storage

X-Ray, diathermy or other equipment are cau​sing interfer​ence

A metal bed is causing interfer​ence

The patient cable is faulty

The CT200 is faulty
Wash with alcohol or soap and reapply ECG Elec​trode Gel

Wash with alcohol or soap after each use. Very dirty electrodes may need to be cleaned with a metal polish or replaced.

Do not use disposable electrodes on more than one patient. If an electrode falls off, make sure it is still "sticky" before replacing it.

Tighten the terminals and make sure that the electrical connec​tions are clean

Tighten the straps so that the elec​trodes are held firmly against the pa​tient

Make sure that the pa​tient is warm and com​fortable, and ask them to relax dur​ing the re​cord​ing

Apply more gel to the elec​trodes. Use extra gel if there is hair at the electrode sites.

Check the "Use By" date and re-apply electrodes if required

Switch off the interfer​ing equipment or use the CT200 in another room. Also, try record​ing with the plug-pack disconnected

Make sure that the bed is grounded. If not, ask a biomedical tech​nician to ground it

Replace the cable (see How to Order Acces​sor​ies)

Call service

Printout is aborted and the message Print Limit appears while using the 3 channel format.
The printing of some leads can surpass the allocated paper space due to a large ECG signal.
Reduce the size to 5mm/mV, or use a single channel format, or examine the lead in question with the Manual format.

 PC Link
PROBLEM
CAUSE
SOLUTION

The PC Link format does not operate
The CT200 is not connected to the PC.

The CT200 is not turned on.

The PC is not set up correctly.
Connect the CT200 and the PC using the PC Link cable.

Switch on the CT200.

Refer to the PC Link manual supplied.

 Installation

PROBLEM
CAUSE
SOLUTION

Failed to complete installation
Some MS Windows files are in use at the time, not permitting copying of all installation files.

Insufficient hard disk space 

Damaged installation disks
Ensure no applications are running before installing PCLink.

Check that the ‘Start Up’ group or folder does not activate any applications which may interfere.

Make more space available

Use MS Windows FileManager or Explorer to check installation disks are readable.

 Recording an ECG - Problems

PROBLEM
CAUSE
SOLUTION

“COM port is not available.

Please check that the port is present in your computer, and that no other application is using it.” dialog box appears
PCLink recognises that the serial port is not available.
Try another serial port, use a suitable 25 pin to 9 pin converter if necessary.

Ensure no other application is using the serial port.

Consult your PC supplier.



“ CT200 not responding ”dialog box appears with 

 “ Please check:

1. CT200 is linked to PC’s Com port.

2. Cable used is the one supplied with CT200.

3. CT200 is turned on.”
PCLink recognises that the serial port is working, yet the CT200 is not responding.


Check the “ CT200 not responding ” dialog box suggestions.

Check CT200 battery level.

CT200 may require servicing.

“Timeout waiting for transmission” dialog box appears
CT200 has identified itself to PCLink but data has not arrived.

CT200 may have been busy (internally)

Serial Port may be incorrectly configured.
Check CT200 battery level.

CT200 may require servicing.

Re-attempt recording.

Try another serial port, use a suitable 25 pin to 9 pin converter if necessary.

“ Lead I data corrupted ” dialog box appears.
An Interpretive CT200 (CT200 I/D ) has been used with a pre- Version 5 PCLink.
Upgrade to at least PCLink Ver 5.

“ Parity Error ” dialog box appears
Serial port may be incorrectly configured.
Try another serial port, use a suitable 25 pin to 9 pin converter if necessary. 

Consult your PC supplier.

 Recording an ECG- Positive Indications

POSITIVE SIGN
MEANING

The CT200 small LCD briefly displays “ CT200 PCLink ”.
PCLink has set the CT200 into PCLink Record mode. 



The narrow bar appears at the bottom of the screen.
The CT200 has identified itself to PCLink and ECG data transfer is about to begin.



The narrow bar begins to fill with a growing blue bar from left to right.
The ECG data transfer is in progress.



 Mailing an ECG

PROBLEM
CAUSE
SOLUTION

After mailing an ECG(s) the computer freezes.


The modem is already in use by another application.

Several applications are open at once, draining available resources.
Ensure the modem is setup for MS Mail 3.5 for Win 3.11

Close any unnecessary applications before mailing.

The ECG appears to have been sent ( the status changes to S ) yet the destination has not received it.


The modem may not be installed correctly. Check that your recently composed ECG message is not still in the MS Mail Outbox.

There may be a System Message in the MS Mail Inbox indicating a mailing problem
Consult the Send/Mail ECGs chapter.

Contact M.M.S.




 Service and Maintenance

Maintaining the CT200

The CT200 needs no special maintenance for reliable operation. 

Suction bulbs and limb straps should be cleaned after each use with warm soapy water. Electrodes with a build up of gel or corrosion can be cleaned with a metal polish, but may need to be replaced for best results. Patient cable connectors should be cleaned with alcohol.

Clean the CT200 with warm soapy water, taking care to avoid water ingress. Do not use acetone, alcohol or other solvents to clean the CT200 as they may damage surfaces.

Service

If problems do occur with the CT200 first check the Problems and Solutions section of the manual. If the problem persists, contact your supplier, an authorised service centre, or Macquarie Medical Systems at the address below:

Macquarie Medical Systems

Service Department

301 Catherine St

Leichhardt NSW 2040

AUSTRALIA

Telephone: +61 2  9692 7911

Facsimile:+61 2  9692 7965

Email: mms@machealth.com.au
European Union Representative

Macquarie Medical Systems

Service Department

35 Catherine Street

Leichhardt NSW 2040

AUSTRALIA

Telephone: +61 2  9692 7911

Facsimile:+61 2  9692 7965

Email: mms@machealth.com.au

Ordering Accessories

Accessories, supplies, and replacement parts can be ordered from your supplier.

For current prices and part numbers please contact your supplier, or Macquarie Medical Systems:

Internet : www.machealth.com.au

Telephone: +61 2  9692 7911

Facsimile:+61 2  9692 7965

Email: mms@machealth.com.au

STANDARD ACCESSORIES
Model

European Power Transformer
e6-001

US Power Transformer
e6-002

Australia Power Transformer
e6-003

UK Power Transformer
e6-004

Patient cable (defibrillation) -Euro
e3-0001

Patient cable (defibrillation) -US
e3-0002

Limb Electrode(4mm) set of 4
e4-007

Limb Strap set of 4
e4-008

Electrocardiograph gel
e4-009

Adaptor clips (set of 10)
e4-002

Small thermal paper roll 
e5-002

Stand
e2-0002

Stand screw
e2-0003

Carry Bag
e2-0001

Operation manual (English) 
e1-0002

CT200 PC Softare & Operation Manual
e1-0005

CT200 PC Cable 
e1-0006

OPTIONAL ACCESSORIES


Large thermal paper roll
e5-003

CT200 Service Manual
e1-0003

12 lead electrocardiograph simulator
e2-0004

A4 ECG paper
e5-005

Technical Information

Classification

Class II/Internally Powered, Type CF Defibrillator Proof

Input


Standard 12 lead US or European coded as per IEC 62D

Power Supply
Internal battery power recharged using mains adaptor supplied. Can be directly connected to a 9-16V 1A AC/DC supply which conforms with the requirements of IEC601.1




Battery type: 6V 3AH lead-acid

Weight

1.5kg

Dimensions

210mm x 165mm x 45mm

Safety Standards
Approved to IEC601.1 




Approved to AS3200.1-1990




Approved to AS3200-1986




Approved to MIL-STD 810D Methods 514.3, 516.3

Designed to meet or exceed requirements of AAMI EC11-1983 and UL544

Test methods

EC11-1983 3.2.7.2: Frequency response tested by methods A, B, and C

QRS Detect

Active low, connector pin 19




Ground, connector pin 7

Warranty

1.
Macquarie Medical Systems warrants this product for a period of twelve months from the date of delivery. This warranty covers any defects in material or manufacture provided that this product has not been subject to accident, misuse, negligence or abuse.

2.
The warranty is limited to repair or replacement of faulty compo​nents or sub‑assemblies and applies when the faulty unit is returned to an author​ised service centre.

3.
Due to their nature, connectors, cables and batter​ies cannot be covered by this warranty.

4.
Macquarie Medical Systems cannot be held respon​sible for any damage that may occur to other instruments or equipment connected to this product.

5.
Macquarie Medical Systems' objective is to design and manufacture quality medical equipment for health care professionals. We need feedback from our customers to constantly improve our products. Please send any comments, suggestions or com​plaints to:

The Product Manager (Cardiac Monitoring)

Macquarie Medical Systems

Service Department

301 Catherine Street

Leichhardt NSW 2040

AUSTRALIA

Telephone: +61 2  9692 7911

Facsimile:+61 2  9692 7965

Email: mms@machealth.com.au

Medical Product Range

Macquarie Medical Systems manufacture and supply a range of medical  equipment:

SYMBOL 183 \f "Symbol" \s 10 \h
CT100 Portable 1/3 channel electrocardiograph

SYMBOL 183 \f "Symbol" \s 10 \h
CT200 Portable 1/3 channel, programmable electrocardiograph with  PC Link 3/6 & 12 channel.

· CT200 VET Portable, programmable veterinary electrogardiograph with PC Link, 1/3 and 6 channel.

· CT300 Portable multi-channel, programmable electrocardiograph with PC Link 3/6 & 12 channel.

SYMBOL 183 \f "Symbol" \s 10 \h
CT1000 Bedside monitor with ECG

SYMBOL 183 \f "Symbol" \s 10 \h
CT2000 Bedside monitor with ECG and paper recorder

SYMBOL 183 \f "Symbol" \s 10 \h
CT3000 Bedside monitor with ECG, SaO2 and NIBP

SYMBOL 183 \f "Symbol" \s 10 \h
CT3100 Bedside monitor with ECG and SaO2
SYMBOL 183 \f "Symbol" \s 10 \h
CT3200 Bedside monitor with ECG and NIBP

SYMBOL 183 \f "Symbol" \s 10 \h
CS3000 Central Monitoring System for 8 beds with multiparameter

Contact your supplier for more details on these products. 

 Existing Patient�xe "Patient Details: Existing Patient"� 





Plug-pack socket





PC and Printer Link Socket





Set-up Keys





Paper Well





Battery on Charge light








Function Keys





The ECG traces will scroll across the display area from right to left like a digital scope.





ON/STANDBY Key





LCD Display





Thermal Print Head





Patient lead socket





MANUAL record





AUTO record





Display area





Selects 12 or Single lead





Starts recording/Monitoring
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